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Introducción  
 
En esta guía podrá observar los temas dictados en el curso “Revit Mep Documentación” 
cada tema incluye una breve explicación de este, los pasos a seguir para desarrollarlo y 
en algunos casos, notas informáticas.  
 
Cuando el tema solicite seleccionar un comando este se remarcara en Negritas 
Cuando el tema mencione un nombre o texto en inglés estará remarcado en cursiva  
Para indicar los pasos a realizar, estarán enumerados 1,2,3,4,5 
Cuando este anexa una nota, se remarcará el texto Nota en negritas  
Hay Gráficos para que la información pueda ser más clara y especifica  
 
Dentro del módulo de modelado avanzado se analizó, se creó, se aplicó y se comprendió 
el uso de las herramientas de modelado y administración de proyectos en la disciplina de 
Sistemas (MEP). 
Se vieron el uso de las herramientas para poder modelar equipos, accesorios, 
componentes, se comparó las diferentes formas que se pueden realizar. En cuanto a las 
herramientas de administración, se vieron cómo se llevan a cabo, como funcionan y como 
pueden algunas de estas aplicarse en modo colaborativo. Se aplico como desarrollar un 
modelo central y un local y en caso de perder el central, como recuperar la colaboración 
mediante la creación de un nuevo central a partir de un local.  
 
Dentro de este módulo se enseñará a documentar la información elaborada de un proyecto, 
se mostrará la creación de vistas de las cuales cuentan con diferentes tipos de utilidades 
para documentar al proyecto. Se explicará cómo generar familias de dos dimensiones para 
complementar al proyecto o para agregar detalles. Se mostrará cómo desarrollar un pie de 
plano, como incluir un listado de cuantificación de nubes de revisión. 
En el tema de listados se explicará cómo realizar un listado de cuantificación donde incluya 
parámetros de información y parámetros cuantitativos, de estos obtener la sumatoria de 
los datos, manejo de fórmulas para obtener totales, personalización de los listados e 
imágenes de elementos sobre los listados.  
En temas de documentación de vistas se verá cómo hacer uso de filtros, creación de filtros, 
como colocar cotas, ingreso de notas clave, creación de etiquetas, el uso de espacios y 
zonas para los sistemas de refrigeración e identidad de los espacios. La representación de 
esquemas de color en ductos y tuberías servirán para poder identificar los sistemas de 
clasificación, tamaños, longitudes y otras propiedades que el usuario desee ver.  
Por último, en temas de publicación e impresión se verá como publicar a formatos de 
AutoCAD (DWG) y a formatos digitales de publicación de tal forma que puedan ser vistos 
en dispositivos digitales.  
 
Se estará haciendo uso de algunas herramientas usadas dentro del módulo de 
fundamentos, y avanzado en este módulo, por ende, podrá localizar con mayor rapidez la 
herramienta solicitada.  
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Creación de vistas 
 
Revit cuenta con diferentes tipos de vistas, estas sirven para poder documentar la 
información del proyecto. Las vistas que se verán a continuación son las siguientes: 
 

Vista de corte, corte Multisegmento 
 
Las vistas de corte son proyecciones verticales que permiten ver el modelo a partir de una 
línea de corte, esta línea corta la geometría y con una dirección muestra la geometría. 
Dentro de la herramienta de corte hay un derivado, el corte, este es el multisegmento, este 
tipo de corte permite generar diferentes líneas de proyección a diferentes profundidades 
sobre el mismo corte de tal forma que se puedan apreciar diferentes partes del edificio. 
 
Vista de corte 
 
Para crear una vista de corte necesitara contar con un proyecto abierto donde pueda hacer 
uso de la herramienta.  
 

1. Seleccione la pestaña view => Panel Create => Herramienta o comando Section 
2. Marque un primer punto para el inicio del corte y un segundo punto para el segundo 

corte. 
 

 
3. Acceda al corte. De doble clic sobre el icono o simbología del corte. 
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Cambio de rango de visualización de corte 
 
Todo corte generado cuenta con herramientas de visibilidad los cuales sirven para delimitar 
el rango visión. En vista de planta se mostrarán unas flechas de color azul con las cuales 
el usuario podrá controlar la profundidad y largo de corte como se muestra a continuación. 
 

 
 
Ejemplo de cambio de profundidad en el corte donde se realizó el cambio desde una vista 
de planta. 
 

 
 
En una vista de corte podrá seleccionar los puntos de control azul los cuales permiten 
modificar la visibilidad de corte en el sentido vertical. Seleccione los puntos de color azul y 
mueva los puntos de tal forma que cambie la visibilidad de la vista de corte.  
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Vista de corte multisegmento 
 
La vista de corte multisegmento se forma a partir de una vista de corte existente, para 
generar el corte multisegmento siga estos pasos: 
 

1. Seleccione el corte que desea convertir en multisegmento. 
2. Seleccione la pestaña Modify => Panel Section => Comando Split Segment. 
3. Con la herramienta corte la línea de la sección de tal forma que designe el número 

de cortes y direcciones. 
4. Seleccione las flechas de color azul para controlar las líneas de corte 

multisegmento. 

 
 

Vista de elevación e indicadores de profundidad 
 
Las vistas de elevación es una herramienta que permite ver las fachadas de proyecto, si 
esta se coloca sobre la geometría del proyecto permitirá hacer semejanza a la vista de 
corte. Tanto las vistas de corte como vistas de elevación cuentan con la propiedad de 
modificar la profundidad de este.  
 
Vista de elevación 
Para crear vista de elevación siga estos pasos: 
 

1. Seleccione la pestaña View => panel Create => Comando Elevation 
2. Ubique el lugar de posicionamiento donde colocara la elevación sobre el proyecto. 

 
3. Seleccione con una ventana de selección la elevación. Use la herramienta de 

rotación para cambiar el posicionamiento de la orientación de la vista de elevación. 
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4. Seleccione el triángulo de proyección para controlar línea de proyección de la 
elevación. 

 
5. Acceda a la vista de elevación, cambie la disciplina de ser necesario. 

 
 
 
Indicador de profundidad 
 
Para activar el indicador de profundidad deberá contar con una vista de corte o de elevación 
y estar dentro de ella.  

1. Seleccione la herramienta Visual Style en la barra de controles de vista, en el 
cuadro de estilos seleccione la opción Graphic Display Options. 

2. Identifique el parámetro Depth Cueing. Active la casilla de la opción Show Depth. 
 

 
3. Seleccione el botón Apply para observar los cambios en la vista y el parámetro de 

profundidad activo.  
 

 
4. Use el parámetro Near o Far para acercar o alejar el efecto de profundidad. Con el 

parámetro Fade Limit permite tener un control de efecto de profundidad. 
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5. Cierre el cuadro de dialogo y repita estos pasos en las vistas que necesite aplicar la 
profundidad de vista. 

 
 

Plantilla de vista 
 
La plantilla de vista es una herramienta que permite estandarizar las vistas, esta 
herramienta permite guardar todas las propiedades con las cuales al crearse la plantilla de 
vista y esta cargarse en otra vista la plantilla. Toda propiedad que tenga almacenada la 
plantilla no se podrá modificar desde la herramienta original, se tendrá que acceder a las 
configuraciones para poder modificar la propiedad. 
Para poder crear la plantilla de vista a partir de una existente deberá de haber realizado los 
cambios gráficos en las propiedades de las categorías el proyecto como se muestra a 
continuación.  
 

 
 
Creación de plantilla a partir de una vista 
 
Pasos para crear una plantilla de vista  

1. Seleccione la pestaña view => Panel Graphics => View Templates => opción 
Create Template From Current View. 

2. Ingrese el nombre a la nueva plantilla de vista. 

 
 

3. En las configuraciones de plantilla de vista active o desactive las propiedades que 
desea incluir en la plantilla de vista. 

 



 

11 
 

 
4. De clic ok para terminar la creación de la plantilla de vista 

 
Cargar plantilla en una vista nueva 
 
Para cargar una plantilla de vista siga estos pasos 

1. Seleccione el apartado Identity data de las propiedades de la vista. Seleccione la 
opción View Template. 

2. En el cuadro de dialogo seleccione la plantilla creada. De clic en el botón OK para 
cargar la plantilla de vista. 
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Modificar las propiedades de una plantilla de vista 
 
Para poder modificar la plantilla de vista siga estos pasos 
 

1. Seleccione la pestaña view => Panel Graphics => View Templates => opción 
Manage view templates 

2. Seleccione la herramienta o propiedad que desea modificar 

 
3. Identifique la propiedad que desea modificar, a continuación, se muestra cómo se 

está cambiando el color a la categoría de muros 

 
 

4. De clic en OK y cierre las configuraciones de la plantilla de vista para ver los cambios 
realizados. 

 

 
Quitar plantilla en una vista  
 
Para quitar una plantilla de vista siga estos pasos 
 

1. Identifique el apartado Identity Data. Seleccione la opción view Template 
2. En el cuadro de configuración de plantilla de vista seleccione la opción <None> 

después de clic en el botón OK para confirmar y quitar la plantilla de vista 
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Cambios realizados en una vista 3d, se ha retirado la plantilla de vista. 
 

 
 

Vista de leyenda  
 
La plantilla de vista es una herramienta que permite documentar las familias internas dentro 
del proyecto, permite colocarlas en proyección 2D es decir en vista de planta y laterales. 
Dentro de esta vista se puede agregar líneas, imágenes, regiones o mascaras. Estas vistas 
se generan en un apartado diferente en el navegador de proyecto. 
 
Creación de vista de leyenda 
 
Para crear la vista de leyenda necesitara contar con un proyecto abierto o activo. 

1. Seleccione la pestaña View => Panel Create => Comando Legends => opción 
Legend 

2. Ingrese un nombre a la vista de leyenda y una escala. Confirme los cambios, de clic 
en el botón ok para crear la vista de leyenda. 

 
3. Corrobore la creación de la vista en el navegador de proyecto 
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Uso de herramientas graficas para documentar en vista de leyenda 
 

▪ Líneas de detalle 
Haga uso de las líneas de detalle para definir contornos, detallar o separa la información en 
esta vista. 
 

1. Seleccione la pestaña Annotate => Panel Detail => Comando Detail Line 
2. Haga uso de las herramientas de dibujo para definir los detalles. Seleccione la 

pestaña Modify / Place Detail Lines => Herramienta de dibujo 

 
 
Ejemplo de uso de herramientas de líneas para generación de contornos 

 
▪ Region 

 
La región es una herramienta que permite generar un área y sobre esta aplicar un patrón. 
Este patrón puede contar con un color y un contorno. 
Para hacer uso de la herramienta siga estos pasos: 

1. Seleccione la pestaña Annotate => panel Detail => comando Region 
2. En la pestaña Modify seleccione las herramientas de dibujo y genere un objeto 

 

 
3. El objeto debe ser cerrado para el funcionamiento de la región 
4. En el selector de tipos, seleccione el tipo de patrón a utilizar 
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5. Finalice la creación. Seleccione la pestaña Modify => Panel Mode => comando 
Finish y observe los resultados 

 
 

▪ Maskin Region 
 

1. Seleccione la pestaña Annotate => panel Detail => comando Masking Region 
2. En la pestaña Modify seleccione las herramientas de dibujo y genere un objeto 

 
3. El objeto debe ser cerrado para el funcionamiento del Masking región 

 
4. Finalice la creación. Seleccione la pestaña Modify => Panel mode => comando 

Finish y observe los resultados 

 
 
Componente de leyenda 
 
Pasos para colocar un componente de leyenda 
 

1. Seleccione la pestaña Annotate => panel Detail => comando Legend Component  
2. En la barra de opciones seleccione la familia que desea colocar como leyenda  
3. Seleccione el modo de proyección de la leyenda de la familia 

 
4. Coloque la leyenda sobre el área de dibujo. Repita esos pasos para colocar las 

demás leyendas en la vista 
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Vista de detalle  
 
Las vistas son una herramienta eficiente para documentar detalles constructivos del 
proyecto. Estas se generan a partir de un área específica, de esta se genera una nueva 
vista a partir de la original. Esta vista se puede cambiar la escala de tal forma que sea más 
grande y con ello se pueda documentar la información.  
 
Creación de vista de detalle 

1. Seleccione la pestaña View => panel Create => comando Callout 
2. Seleccione cualquiera de los dos modos de creación. Si selecciona el modo 

Rectangle, dibuje un rectángulo para la vista de detalle. Si selecciona Sketch use la 
herramienta de dibujo para generar el área de la vista de detalle 

 
3. Corrobore la creación de la vista. Acceda a la misma, de doble clic sobre la vista 

 
4. Puede agregar texto, líneas y regiones para detallar la vista 
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Componente de detalle 
 
Pasos para crear la vista de detalle 
 

1. Seleccione el menú file => New => Family 
2. Seleccione la plantilla Metric Detail Item 

 
3. Con las herramientas de dibujo Line, Filled Region y Masking Region genere un 

componente de detalle como el que se muestra a continuación 

 

 
 

4. Guarde la familia. Menú file => Save as => family => Ubicación de guardado. 
Cargue al proyecto. Pestaña Modify => panel Family editor => Load intro Project 
and Close. 

 
Ejemplo de uso de componente de detalle 
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Vistas Drafting 
 
Las vistas Drafting es una herramienta grafica que permite documentar de forma general el 
proyecto. Para poder crear estas vistas siga estos pasos. 
 

1. Seleccione la pestaña View => panel Create => Comando Drafting view 
2. Ingrese el nombre y la escala que tendrá la vista Drafting 

 
3. Creada la vista Drafting coloque textos, imágenes, regiones y líneas para 

documentar la información 

 
Ejemplo de uso y creación de vista Drafting view 
 

 
 

Perspectivas de cámara 
 
Creación de cámara 3d 

1. Seleccione la pestaña View => panel Create => 3D View => opción camera 
2. Marque un punto inicial para la colocación de cámara y un segundo punto para 

colocar el público de esta 
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3. Orbite y ajuste la cámara para colocar el posicionamiento de la cámara 
 
 

 
 
 

4. Seleccione el cuadro delimitador de la vista, con los puntos de control seleccione 
los puntos azules para ampliar la vista 

 

 
 
 
Ajustar el tamaño de la vista de cámara 
Para ajustar el tamaño de la cámara siga estos pasos 

1. Seleccione el recuadro delimitador de la vista 
2. Seleccione la pestaña Modify => panel Crop => comando Size Crop 

 

 
 
 

3. Ajuste el modo de escalado en las propiedades “Change”  
4. Ajuste las propiedades del tamaño en milímetros. Cambie los valores y cierre el 

cuadro de dialogo => de clic en el botón en OK 
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Ejemplo ilustrativo de cambio de tamaño de vista 

 
 
Ajuste de altura de cámara 
 
Para ajustar la cámara puede hacer uso de dos parámetros, el ojo de elevación y objetivo 
de elevación. Estos parámetros los encontrara en las propiedades de la vista.  
 
Eye Elevation: Este parámetro es el ojo de elevación, la cámara, permite colocar el valor 
de la altura de esta mediante un valor numérico.  
Target Elevation: Este parámetro es el objetivo de elevación, permite colocar el valor de la 
altura de esta mediante un valor numérico. 

 
Corte de proyección de vista 3D 
 
El corte de proyección permite delimitar la profundidad de la vista mediante un valor 
numérico. En las propiedades de la vista en el apartado Extents en el parámetro Far Clip 
offset ajuste mediante un valor numérico la profundidad. Observe el siguiente ejemplo. 
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Vistas de planes 
 

Nubes de revisión 
Las nubes de revisión es una herramienta grafica que permite colocar una nube con la 
información de la revisión u observación por corregir. Para esto se debe generar un listado 
de revisiones y estas a su vez deben contar con la información u observación.  
 
 
Creación de listado de revisiones  
 

1. Seleccione la pestaña View=>Panel Sheet Composition=>Comando Revisions 

 
2. En el cuadro de dialogo de revisiones de planos seleccione el botón Add para 

agregar una nueva revisión 
 
Ajuste las siguientes propiedades 
 

A) Revisión Number: Numero o letra de revisión  
B) Numbering: Modo de ordenamiento de las revisiones  
C) Date: Fecha de emisión de revisión  
D) Description: Descripción de la revisión  
E) Issued to: Receptor de revisión 
F) Issued by: Emisor de revisión  
G) Show: mostrar tag o no 

 
3. Cierre el cuadro de dialogo. De clic en el botón OK para finalizar la creación del 

listado de revisiones 
 
Cargado de etiqueta de nube de revisión  
 
La etiqueta permite identificar y diferenciar la revisión en cada caso. Para cargar la etiqueta 
siga estos pasos. 
 

1. Seleccione la pestaña Insert => Panel Load From library => Load Family  
2. Seleccione la etiqueta llamada M_Revision Tag 
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3. De clic al botón open para cargar la familia de tag de nube de revisión 

 
Creación de nube de revisión  
 
Para generar la nube de revisión primero tendrá que estar colocado en un plano para 
dibujarla. 

1. Seleccione la pestaña Annotate => panel Detail => Comando Revisión cloud 
2. Con las herramientas de dibujo genere la nube. 

 

 
 

3. Finalice la creación. Seleccione la pestaña Modify => panel Mode => Comando 
Finish 

4. En las propiedades de instancia seleccione la revisión que le corresponde 
 

 
 
Colocación de etiqueta en nube de revisión 
 

1. Seleccione la pestaña Annotate => panel Tag => comando Tag by Category 
2. Seleccione la nube de revisión  
3. De clic a el botón Modify para terminar la colocación  

 

 
 
Corroboración de revisiones en planos 
 
Colocadas las nubes de revisión sobre el plano, estas se mostrarán en el listado de nubes 
de revisión que trae el pie de plano como se muestra a continuación. 
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Creación de pie de plano 
 
Revit le permite crear un pie de plano personalizado independiente del pie de planos 
existentes. Para esto deberá crear una familia a partir de una plantilla existente. Posterior 
de contar con la familia podrá hacer uso de las herramientas graficas para generar el pie 
de plano. Una vez creado podrá hacer uso del pie de plano para diferentes proyectos.   
 
Selección de plantilla y ajuste de tamaño 
 
Para la selección de la plantilla siga estos pasos 

1. Seleccione el menú file => New => opción Title Block  
2. Seleccione el formato deseado => botón open 

 
 
Para ajustar el tamaño siga estos pasos 

1. Seleccione una de las líneas del pie de plano. Seleccione la cota temporal y cambie 
el valor numérico 

2. Repita este paso en el otro sentido para ajustar el tamaño del plano 

 
 
Creación de estilos de línea 
Deberá de contar con una familia de plano para poder crear los estilos de línea. Para crear 
los estilos de línea siga estos pasos: 

1. Seleccione la pestaña Manage => panel Settings => Comando Object Styles  
2. En el cuadro de dialogo seleccione la opción New para crear un nuevo estilo de 

línea 
3. En el cuadro de dialogo ingrese el nombre y la subcategoría de las líneas a Title 

blocks 
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4. Cambie las propiedades del estilo de línea. Cambie el grosor, color y patrón. 
 

 
 

5. Seleccione el botón OK para terminar la creación del estilo de línea 
 
Creación de pie de plano 
 

1. Con las herramientas de dibujo y los estilos de línea dibuje las divisiones para el 
diseño del pie de plano como se muestra a continuación.  

 

 
 

2. Agregue etiquetas de información del plano. Seleccione la pestaña Create => panel 
Text => Panel Label 

3. Seleccione en el área de dibujo para dar clic y colocar la etiqueta 

 
4. En el cuadro de dialogo ingrese el parámetro que desea mostrar en el pie de plano 
5. Repita el paso número cuatro para agregar más etiquetas 
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6. Agregue textos e imágenes para detallar el pie de plano como se muestra en la 
ilustración 

 

 
 

7. Guarde la familia para su posterior uso. Seleccione el menú file => save as => 
ubicación de guardado de familia de pie de plano => save 

 

 
Cargado de pie de plano en proyecto 
 
Para cargar un pie de plano en un proyecto siga estos pasos. 

1. Seleccione la pestaña View => panel Sheet Composition => Sheet  
2. En el cuadro de dialogo seleccione el botón Load… 
3. Ubique y seleccione la familia de pie de plano. De clic en el botón open 
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4. Seleccione el pie de plano cargado. De clic en el botón OK para crear un plano con 
el nuevo formato (familia de pie de plano) 

 

 
 

Duplicado de vistas 
Revit cuenta con tres tipos de duplicado de vista, cada uno de los duplicados sirven para 
cierta función. 
 
Duplicado básico 
El duplicado de vista básico sirve para duplicar la vista sin los detalles o componentes de 
anotación. Para hacer un duplicado de vista siga estos pasos: 

1. Seleccione la pestaña view => panel Create => Comando Duplicate view  
2. Corrobore la creación de vista por debajo de la original en el navegador de proyectos 

 
Ejemplo de copiado básico 
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Duplicado con detalle 
El duplicado de vista con detalle sirve para duplicar la vista con los detalles o componentes 
de anotación. Para hacer un duplicado de vista siga estos pasos: 
 

1. Seleccione la pestaña view => panel Create Comando Duplicate with Detailing  
2. Corrobore la creación de vista por debajo de la original en el navegador de proyectos 

 

 
Ejemplo de copiado con detalle  
 

 
 
 
Duplicado con dependencia  
El duplicado de vista con dependencia sirve para duplicar la vista con los detalles o 
componentes de anotación, pero mantiene la conexión con la vista original de tal forma que 
cualquier elemento de anotación que se dibuje o se coloque en una de las dos vistas se 
observara en la otra. 
 

1. Seleccione la pestaña view => panel Create =>Comando Duplicate as Dependent 
2. Corrobore la creación de vista por debajo de la original en el navegador de proyectos 

 

 
Ejemplo de copiado con dependencia 
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Listados de cuantificación  
 
Los listados es una herramienta grafica con información cualitativa y cuantitativa obtenida 
a partir de lo generado o modelado en el proyecto. Dentro de sus características principales 
que cumplen los listados es la posibilidad de organizar la información por categoría, manejo 
de información, filtrado de la misma, uso de fórmulas para conectar dos o más parámetros 
mediante matemáticas básicas (suma, resta, multiplicación y división) así mismo, cuenta 
con herramientas de personalización para la apariencia del listado. 
 

Listados de planos 
 

1. Seleccione la pestaña View => panel Create => Comando Schedule => opción 
Sheet List  

2. En el cuadro de dialogo Sheet List Properties seleccione los parámetros que desea 
obtener en el listado de cuantificación. De clic en el botón OK para crear el listado  

 

 
Ejemplo de modelo de listado de planos 
 

 
 
Nota: en caso de requerir modificar un parámetro, puede hacerlo directamente sobre el 
listado de cuantificación  
 

Listados de cuantificación  
 
Para generar un listado de cuantificación mono categoría siga estos pasos. 
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1. Seleccione la pestaña View => panel Create => Comando Schedule => opción 
Schedule / Quantities 

2. En el cuadro de dialogo seleccione la categoría que desea cuantificar 
 

 
 

3. En el cuadro de dialogo de propiedades del listado de cuantificación, seleccione los 
parámetros que quiere incluir en el listado de cuantificación. De clic en el botón Ok 
para terminar la creación del listado 

4. Corrobore la creación del listado de cuantificación con los parámetros solicitados 
 

 
 

Organización de la información de los listados de cuantificación  
 
Para organizar la información de un listado de cuantificación, necesitara contar con un 
listado creado. Siga estos pasos: 
 

1. Seleccione el apartado Other de las propiedades de instancia del listado de 
cuantificación => Seleccione la opción Sorting / Grouping 

2. En el cuadro de dialogo, en el parámetro Sort by seleccione el parámetro con el que 
desea agrupar la información 

3. Active la casilla Grand Totals para mostrar los totales de la información del listado 
de cuantificación. De clic en el botón OK para terminar la organización de la 
información 

 
Nota: Si desactiva la casilla Itemize every Instance lo que ara el programa es solo mostrar 
un tipo de cada elemento y no todos los elementos, esto hace que el listado de 
cuantificación reduzca su tamaño notoriamente. 
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Filtro de información en listados 
 
La herramienta filtro le permite concentrar la información sobre la que usted necesite. Para 
eso deberá indicar sobre que parámetro desea filtrar la información y sobre que regla. A 
continuación siga estos pasos: 
 

1. Seleccione el apartado Other de las propiedades de instancia del listado de 
cuantificación => Seleccione la opción Filter 

2. En el cuadro de dialogo, en las propiedades de los filtros, seleccione el parámetro 
con el que desea filtrar la información. Use una de las reglas que existen para 
controlar el parámetro seleccionado. De clic al botón OK para terminar el filtrado de 
información. 
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Manejo de imágenes en listados de cuantificación  
 
Para hacer uso de imágenes en los listados, deberá de contar con un listado creado. Siga 
estos pasos: 

1. Seleccione el apartado Other de las propiedades de instancia del listado de 
cuantificación => Seleccione la opción Fields  

2. En el cuadro de dialogo seleccione el parámetro llamado Image. De clic en el botón 
ok para terminar de agregar el parámetro 

 

 
3. Seleccione en el listado de cuantificación la casilla de imagen. Seleccione los puntos 

suspensivos (…)  para abrir el cuadro de gestión de imágenes 
4. En el cuadro de gestión de imágenes podrá observar todas las imágenes ya 

cargadas 
5. Seleccione el botón Add… para añadir una nueva imagen 

 

 
 

6. Ubique la imagen que desea cargar y seleccione. De clic al botón open para cargar 
al cuadro de dialogo. De clic al botón OK para confirmar la colocación de imagen a 
la celda. 

7. Corrobore la colocación de la imagen en el listado de cuantificación 
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Nota: Las imágenes no serán visibles en los listados de cuantificación hasta que se hayan 
colocado en un plano. Sobre la vista de listado solo mostrara el nombre junto con la 
extensión del formato que cuente 

 
Ejemplo de listado de cuantificación con imagen 
 

 
 

Manejo de fórmulas en listados de cuantificación  
 
Las fórmulas son funciones matemáticas que permiten juntar dos o más parámetros 
mediante una función como suma, resta, multiplicación y división. Para hacer uso de estas 
fórmulas, deberá de contar con un listado de cuantificación donde se puedan hacer uso de 
ellas.  
 

1. Seleccione el apartado Other de las propiedades de instancia del listado de 
cuantificación => Seleccione la opción Fields  
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2. En el cuadro de dialogo seleccione la propiedad llamado Add Calculated 
Parameter 

3. En el cuadro valor de calculo  

 
4. En la propiedad de formula, seleccione la opción Formula para agregar alguno de 

los parámetros como se muestra a continuación 

 

 
5. Confirme los cambios para corroborar la creación del nuevo parámetro y uso de 

formula 

 
 

Personalización de listados  
 
Revit le permite personalizar los listados de cuantificación creados. Para esto deberá contar 
con un listado para poder realizar estos cambios. Estos son los cambios que puede 
personalizar en los listados de cuantificación. 
 
Color de columna en listados de cuantificación  

1. Seleccione la columna o las columnas que desean cambiar el color. 
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2. Seleccione la pestaña Modify Schedule / Quantities => panel Appearance => 
Comando Shading 

3. Seleccione el color que desea tener en la columna. De clic en el botón OK para 
terminar la colocación de color  

 

 
 

 
 
Bordes en listados de cuantificación  
 
Para cambiar los bordes del listado de cuantificación siga estos pasos: 

1. Seleccione las columnas que desea colocar o editar los bordes 
2. Seleccione la pestaña Modify Schedule / Quantities => panel Appearance => 

Comando Borders 
3. En el cuadro de dialogo Edit Borders seleccione los bordes y estilo de línea que 

quiere tener en el listado de cuantificación. 
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Ejemplo de uso de bordes sobre un listado de cuantificación 

 
Fuentes en listados de cuantificación  
 
Cambie la fuente de sus listados de cuantificación, para esto deberá contar con un listado 
existente para realizar estos cambios. 
 

1. Seleccione la columna que desea cambiar la fuente 
2. Seleccione la pestaña Modify Schedule / Quantities => panel Appearance => 

Comando Font 
3. En el cuadro de dialogo de edición de fuentes, seleccione la fuente que desea 

cambiar, ajuste el tamaño de la fuente, cambie la apariencia y color de esta. De clic 
en el botón OK para terminar la creación.  

 

 
Ejemplo de cambio de apariencia de fuente sobre un listado de cuantificación  
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Alineado horizontal y vertical en listados de cuantificación  
 

1. Seleccione las columnas que desea cambiar la fuente 
2. Seleccione la pestaña Modify Schedule / Quantities => panel Appearance => 

Comando Align Horizontal, Align Vertical 

 
Ejemplos de alineado en un listado de cuantificación  
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Documentar vistas 
 

Manejo de escalas y grosores de línea 
 
Ajuste de grosor de líneas 
 
Para ajustar el grosor de líneas de las categorías, siga estos pasos: 

1. Seleccione la pestaña View => panel Graphics => Comando Visibility Graphics  
2. Seleccione la pestaña Model categoríes. Seleccione el botón Object Styles… 

 
3. Seleccione la categoría que desea modificar o cambiar sus propiedades 

 
4. Cambie o ajuste las siguientes propiedades 
a) Projection: En proyección asigne un grosor de línea 
b) Cut: En corte asigne un grosor de línea 
c) Line color: Asigne un color a la línea 
d) Line Pattern: Asigne un patrón a la línea 

Nota: en aquellos elementos que aparezca un sombrado en gris no podrá modificar o editar 
esa propiedad, son configuraciones que el sistema trae por defecto. 
 

5. De clic en el botón OK para cerrar el cuadro de dialogo. De clic en el botón OK para 
cerrar Visibility Graphics 

6. Corrobore el resultado de los cambios en la categoría editada 
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Manejo de escalas en grosor de líneas 
 
Para modificar el grosor de líneas de acuerdo a las escalas siga estos pasos: 

1. Pestaña Manage => Panel Settings => comando Additional Settings => Opción 
Line Weights 

 
2. En el cuadro de dialogo cambie el grosor de las líneas. Identifique el numero y la 

escala, seleccione el valor numérico en milímetros y cambie su valor como se 
muestra en la ilustración 

 
3. Cierre el cuadro de dialogo para terminar la edición de líneas. De clic al botón OK 
 

Creación de filtros para controlar propiedades y visibilidad de los objetos y 
sistemas Mep 
 
Los filtros son una herramienta grafica que permite centrar información solicitada por el 
usuario, permite identificarla, gestionarla y visualizarla.  
 
Creación de filtro mono categoría 
 
Pasos para creación de filtro mono categoría 
 

1. Seleccione la pestaña View => Panel Graphics => Comando Filters 

 
2. Cree un nuevo filtro. Seleccione el botón New. Asigne un nombre al filtro. De clic al 

botón OK para finalizar 
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3. Seleccione la categoría que desea que entren en el filtro 
4. Seleccione la propiedad o el parámetro sobre el cual se filtrará la información  

 
5. Seleccione la regla que aplicara el parámetro  
6. Seleccione el parámetro sobre el cual se va a filtrar la información 

 

 
7. Seleccione el botón Apply y después el botón OK para cerrar el cuadro de dialogo 

y terminar la creación del filtro 

 
 
Creación de filtro multi categoría 
 

1. Seleccione la pestaña View => Panel Graphics => Comando Filters 

 
2. Cree un nuevo filtro. Seleccione el botón New. Asigne un nombre al filtro. De clic al 

botón OK para finalizar 
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3. Seleccione las categorías que desea que entren en el filtro 
4. Seleccione la propiedad o el parámetro sobre el cual se filtrará la información  

 
5. Seleccione la regla que aplicara el parámetro  
6. Seleccione el parámetro sobre el cual se va a filtrar la información 

 

 
7. Seleccione el botón Apply y después el botón OK para cerrar el cuadro de dialogo 

y terminar la creación del filtro 

 
Cargado de filtro en VG 
 

1. Seleccione la pestaña View => Panel Graphics => Comando Visibility Graphics 
=> Pestaña Filters 

 



 

42 
 

2. Seleccione la opción add para añadir el filtro 
3. Seleccione el filtro que desea cargar. De clic al botón OK para cargarlo 
4. Cambie las apariencias graficas del filtro 

 
5. De clic al botón ok para terminar de cargar el filtro  

 
 

Configuración y colocación de cotas 
 
Las cotas son una herramienta grafica de medición y documentación en los proyectos, haga 
uso de estas para acotar la información que necesite. Para colocar las cotas deberá contar 
con un proyecto activo o abierto. 
 
Configuraciones graficas de cotas 
 
Para configurar las propiedades graficas de las cotas siga estos pasos: 
 

1. Seleccione la pestaña Annotate => panel Dimension => Herramienta o comando 
de Dimensión (ejemplo Aligned) 

2. En la paleta de propiedades seleccione el botón Edit Type para entrar a las 
propiedades de tipo de la cota. 

 
3. Seleccione el botón Duplicate => ingrese un nombre nuevo => de clic al botón OK 

para terminar el duplicado. 
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4. Ajuste las siguientes propiedades del apartado Graphics. 

 
 

A) Dimension String Type: Define el estilo del trazo de la línea. 
B) Leader Type: Define el tipo de directriz que tendrá la cota. 
C) Tick Mark: Define el tipo de marca que tendrá la cota.  
D) Line Weight: Define el grosor de la línea de la cota. 
E) Dimension Line Extensión: Define la extensión de la línea de dimensión.  
F) Witness Line Control: Define el control de la línea sobre los elementos o sobre la 

cota. 
G) Witness Line Extensión: Define la distancia de extensión de la línea. 
H) Color: Define el color de la línea. 

 
Configuraciones de texto de cotas 
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1. Para configurar las propiedades de texto de las cotas siga estos pasos Seleccione 
la pestaña Annotate => panel Dimension => Herramienta o comando de 
Dimensión (ejemplo Aligned) 

2. En la paleta de propiedades seleccione el botón Edit Type para entrar a las 
propiedades de tipo de la cota. 

 
3. Identifique el apartado Text y cambie las siguientes propiedades. 

 
A) Width Factor: Cambia el valor de ancho del texto.  
B) Estilos de texto: cambia los estilos de texto como en otros programas de 

documentación.  
C) Text Size: Cambia el tamaño del texto de la cota.  
D) Text Offset: cambia el desfase que tiene el texto con respecto a la cota. 
E) Text Font: Cambia la fuente del texto de la cota. 
F) Text Background: Cambia el fundo del texto de la cota de opaco a transparente 
G) Units Format: Establece el formato de unidad de las cotas. 
H) Alternate Units: Permite colocar como extra-unidades alternativas a las que se 

definan por defecto. 
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Colocación de cotas 
 
A continuación, se muestran los diferentes modos de colocación de cotas.  
 

▪ Colocación de cota Aligned 
1. Seleccione la pestaña Annotate => panel Dimension => comando Aligned.  
2. Seleccione un primer punto para colocar el inicio de la cota. 
3. Marque un segundo punto para marcar el punto final de la cota. 
4. Marque un tercer punto para terminar con la creación.  

 

 
5. Seleccione el botón Modify para terminar el uso del comando.  

 
▪ Colocación de cota Linear 

 
1. Seleccione la pestaña Annotate => panel Dimension => comando Lineal. 
2. Seleccione un primer punto para colocar el inicio de la cota. 
3. Marque un segundo punto para marcar el punto final de la cota. 
4. Marque un tercer punto para terminar con la creación.  

 
5. Seleccione el botón Modify para terminar el uso del comando.  

 
▪ Colocación de Cota Angular  

 
1. Seleccione la pestaña Annotate => panel Dimension => comando Angular. 
2. Seleccione un primer punto para colocar el inicio de la cota. 
3. Marque un segundo punto para marcar el punto final de la cota. 
4. Marque un tercer punto para terminar con la creación.  

 

 
5. Seleccione el botón Modify para terminar el uso del comando.  

 
▪ Colocación de cota Radial 

 
1. Seleccione la pestaña Annotate => panel Dimension => comando Radial. 
2. Seleccione un primer punto para colocar el inicio de la cota. 
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3. Marque un segundo punto fuera del objeto para terminar la creación de la cota. 

 
4. Seleccione el botón Modify para terminar el uso del comando.  

 
▪ Colocación de cota Diameter 

 
1. Seleccione la pestaña Annotate => panel Dimension => comando Diameter. 
2. Seleccione un primer punto para colocar el inicio de la cota. 
3. Marque un segundo punto fuera del objeto para terminar la creación de la cota. 

 

 
 

4. Seleccione el botón Modify para terminar el uso del comando.  
 

▪ Colocación de cota Longitud de arco  
 

1. Seleccione la pestaña Annotate => panel Dimension => comando Longitud de 
arco. 

2. Seleccione el arco que desea medir (Exterior o interior) 
3. Marque con un clic el inicio del arco.  
4. Marque con un clic el final del arco.  
5. De un clic fuera del objeto para crear la cota. 

 

 
6. De clic al botón Modify para terminar la creación de la cota.  

 
Colocación textos  
 
Los textos son una herramienta grafica que permite documentar la información de un 
proyecto. Para poder hacer uso de la herramienta necesitara contar con un archivo abierto 
o activo. 
 

▪ Colocación de textos 
 
Para colocar un texto siga estos pasos: 

1. Seleccione la pestaña Annotate => panel Detail => comando Text. 
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2. De un clic sobre el área de dibujo o genere un cuadro de texto. 
3. Escriba con el teclado un texto o copie un texto.  

 
Ejemplo de texto  
 

 
4. De clic en el botón Modify para terminar la creación del texto.  

 
▪ Directriz en texto  

 
1. Seleccione el texto que desee que tenga directriz.  
2. Seleccione el alineado de la directriz según sea el caso (Derecha o Izquierda) 
3. Seleccione el tipo de directriz (Lineal o Arco) 

 
4. De clic al botón Modify para terminar la creación.  

 
 
Propiedades de edición de texto 
 
Para poder editar un texto deberá seleccionar un texto, de un clic sobre las letras para entrar 
a la pestaña Edit Text. A continuación, encontrara las siguientes herramientas para poder 
editar al texto.  
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▪ Herramientas de fuente 

 
Estilos de fuente  
 

1. Seleccione el texto. En la pestaña Edit text seleccione el texto. 
2. Seleccione cualquiera de los tres estilos de texto ilustrados a continuación: 
 
Bold: Muestra el texto en negritas. 
Italic: Muestra el texto en cursiva. 
Underline: Muestra el texto subrayado.  

 
 

 
 
Propiedades de párrafo 
 

1. Seleccione el texto. En la pestaña Edit text seleccione el texto. 
2. Seleccione cualquiera de las herramientas de párrafo que se ilustran a continuación. 

 
None: No aplica viñetas ni ningún marcador en los párrafos.  
List Bullet: Aplica una boya en los párrafos. 
List Number: Coloca números a cada párrafo.  
List Uppercase letters: Coloca letras mayúsculas a los párrafos. 
List Lowercase letters: Coloca letras minúsculas a los párrafos. 

 
 
 
Configuraciones base de textos 
 
Para configurar las propiedades base de los textos deberá contar con un proyecto activo o 
abierto. 
 

1. Seleccione la pestaña Annotate => panel Text => comando Text 
2. En el selector de tipos seleccionar el botón Edit Type. 
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3. Seleccione el botón Duplicate… para generar un nuevo tipo. De clic en el botón OK 

para terminar el duplicado.  

 
4. Identifique el apartado Graphics y ajuste las siguientes propiedades. 

 
A) Color: Permite asignar color al texto. 
B) Line Weight: Define el grosor de la línea de borde del texto. 
C) Background: Permite seleccionar el modo de fondo que tendrá el texto (Opaco – 

Transparente) 
D) Show Border: Muestra el borde del texto 
E) Leader/Border Offset: Establece el desfase que tendrá la directriz con respecto al 

borde. 
F) Leader Arrowhead: Permite seleccionar la flecha de la directriz.  

 
5. Identifique el apartado text y cambie las propiedades del texto que se muestran a 

continuación: 
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Text Font: Permite cambiar y seleccionar la fuente para el texto. 
Text Size: Especifica el tamaño del texto.  
Tab Size: Especifica el espaciado del texto con la barra espaciadora.  
Font Style: Define el estilo del texto (Negritas, Itálica o Subrayado)  
Width Factor: Define el ancho del texto. 
 
 
 

Notas clave 
 
Las notas clave son una herramienta de etiquetado que permite mostrar información del 
parámetro Keynote que tienen todas las familias. Para esto la herramienta se basa en una 
base de datos generada previamente. Cargada esta base de datos se empieza a etiquetar 
los elementos y a su vez alimentando la información del Keynote del objeto. 
 
Uso de notas clave 
 
Para hacer uso de las notas clave deberá contar con un proyecto abierto o activo. 

1. Seleccione la pestaña Annotate => panel Keynote => Comando Element Keynote 
o Material Keynote  

2. Seleccione un objeto en el proyecto que desee colocar la nota clave. 

 
3. Seleccione la nota clave que le corresponda a el objeto.  
4. Corrobore que en la etiqueta aparezca la nota clave seleccionada. 

 
5. Seleccione el objeto. En las propiedades de tipo del objeto seleccionado, en el 

apartado Identity data, en el parámetro Keynote, corrobore que aparezca el 
número etiquetado. 
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Creación de notas clave 
 
Para generar un listado de notas clave deberá contar con un programa de hojas de cálculo 
donde haya dos columnas, una para colocar la nota clave y la segunda para colocar la 
descripción del elemento. 

1. Abra su programa de hojas de cálculo. 
2. Ingrese en la primera columna las notas clave que desea registrar. 
3. Ingrese en la segunda columna la descripción de los elementos que desea registrar. 

 

 
 

4. Guarde el archivo de hoja de cálculo en dos formatos  
a) TXT 
b) PRN 

 
 
 
Cargado de listado de notas clave 
 
Para cargar un listado de notas clave siga estos pasos: 

1. Pestaña Annotate => panel Keynote => Comando keynoting Settings 
2. En el cuadro de dialogo Keynoting Settings  

 
 

3. Seleccione el archivo txt. De clic en el botón Open para cargar el listado de notas 
clave. 

4. Corrobore que aparezca el siguiente mensaje “Keynote table reloaded 
successfully” 
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5. De clic en el botón Aceptar. De clic al botón OK para cerrar el cuadro de 
configuraciones de notas clave. 

6. Haga uso del nuevo listado de notas clave. 
 

 
 
 

Creación y colocación de etiquetas 
 
Las etiquetas son una herramienta grafica que permite mostrar la información solicitada de 
un objeto. Esta información debe existir, el software no mostrara algo que no está disponible 
o no existe en el mismo. Para hacer uso de la herramienta deberá contar con un proyecto 
activo o abierto y así mismo contar con información que desee obtener.  
 
Creación de etiqueta mono categoría 
 
Para crear una etiqueta mono categoría siga estos pasos: (Ejemplo de etiqueta Electrical 
Fixtures) 
 

1. Seleccione el menú File => New => Family  

 
2. Seleccione la carpeta Annotation => Seleccione la plantilla llamada Generic Tag 

=> De clic al botón Open para abrir la plantilla 
 

 
 

3. Lea el cuadro de texto y después borre. => Seleccione la pestaña Create => panel 
Properties => comando Family Category and parameters. 
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4. Cambie la categoría de la familia, de Generic models a la categoría deseada. De 
clic en el botón OK para terminar el cambio de categoría. Corrobore que en la paleta 
de propiedades se vea el cambio.  

 

 
 

5. Seleccione la pestaña Create => panel text => comando Label. De clic sobre el 
área de dibujo 

 
6. Seleccione el parámetro que desee agregar, use la opción Add Parameter to Label 

(icono flecha verde) para agregarlo. De clic al botón OK para cerrar el cuadro de 
dialogo. 
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7. Ajuste la longitud de la etiqueta con los puntos de control 
 

 
 

8. Guarde la familia. Seleccione el menú file => Save as => Family 

 
 
Creación de etiqueta multi categoría  
 
Para crear una etiqueta mono categoría siga estos pasos: (Ejemplo de etiqueta Electrical 
Fixtures) 
 

1. Seleccione el menú File => New => Family  

 
2. Seleccione la carpeta Annotate => Seleccione la plantilla llamada Multicategory 

Tag => De clic al botón Open para abrir la plantilla 
 

 
3. Seleccione la pestaña Create => panel text => comando Label. De clic sobre el 

área de dibujo 

 
4. Seleccione el parámetro que desee agregar, use la opción Add Parameter to Label 

(icono flecha verde) para agregarlo. De clic al botón OK para cerrar el cuadro de 
dialogo. 
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5. Ajuste la longitud de la etiqueta con los puntos de control 

 

 
 

6. Guarde la familia. Seleccione el menú file => Save as => Family 

 
Trabajo con tags 
 
Para colocar las etiquetas por categoría o multicategoría, deben estar cargadas 
previamente en el proyecto.  
 
Colocación de etiqueta por categoría 
 
Para colocar una etiqueta por categoría, siga estos pasos: 

1. Seleccione la pestaña Annotate => panel Tag => comando Tag by Category 
2. Seleccione los objetos que desea etiquetar y coloque la etiqueta 

 

 
3. Seleccione el botón Modify para terminar la colocación de etiqueta 
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Colocación de etiqueta multicategoría 
 
Para colocar una etiqueta multicategoría, siga estos pasos: 

1. Seleccione la pestaña Annotation => panel Tag => comando Muli - Category 
2. Seleccione los objetos que desea etiquetar y coloque la etiqueta 

 

 
3. Seleccione el botón Modify para terminar la colocación de etiqueta 

 

Colocación de cotas y tags en vistas 3D 
 
Bloqueo de vista 3D 
Para bloquear una vista 3D siga estos pasos. 
 

1. Acceda a la vista 3D donde que desee bloquear 
2. Cambie la orientación de la vista de cómo desee bloquear la vista 

 
 

3. En View Control Bar seleccione la herramienta Block 3D => opción Save 
Orientation and Lock View 

4. Ingrese el nombre a la vista (solo cuando no le cambio el nombre de [3D]) 
 

 
5. Use la herramienta de etiqueta por categoría o multicategoría para etiquetar los 

elementos 
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Activar planos de trabajo para colocación de cotas  
 
Para colocar cotas en diferentes posiciones deberá activar planos de trabajo.  

1. Seleccione la pestaña Systems => panel Work Plane => comando Set 
2. Seleccione en el cuadro de dialogo la opción pick a Plane. De clic al botón OK 
3. Seleccione la cara de un objeto para activar el plano de trabajo 

 

 
4. Haga uso de las herramientas de acotación para acotar la información como se 

muestra la ilustración  

 
5. De clic al botón Modify para terminar la creación de cotas  

 

Creación de espacios y zonas 
 
La herramienta de Espacios y Zonas son herramientas que permiten obtener información 
con respecto al proyecto. Para esto deberá de contar con el proyecto con Rooms creados 
para que la herramienta de espacios los reconozca. 
 
Nota: Consulte el tema Reconocimiento de Rooms en espacios Mep para poder hacer uso 
de este tema.  
 
Creación de espacios 
 
Pasos para la creación de espacios 

1. Seleccione la pestaña Analyze => panel Spaces & Zones => comando Space 
2. Seleccione cada una de las habitaciones que contengan un Room como se muestra 

en la ilustración  
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3. Seleccione los espacios y en las propiedades de instancia de este, ajuste las 
siguientes propiedades 

 

 
 
Upper Limit: Es el limite superior a donde llega el espacio mediante un nivel  
Limit Offset: Es el limite superior a donde llega el espacio mediante un valor numérico  
Base Offset: Es el limite inferior base a donde llega el espacio mediante un valor numérico  
 

4. Seleccione el botón Modify para terminar la creación de espacios. 
 
Creación de zonas 
 
Para crear zonas deberá contar con al menos un espacio creado. Para crear las zonas siga 
estos pasos: 
 

1. Seleccione la pestaña Analyze => panel Spaces & Zones => comando Zone 
2. Seleccione la pestaña Edit Zone => panel Mode => Comando Add Space para 

añadir y Remove Space para remover el espacio. 
 

 
Ilustración de zona creada por dos espacios 
 

 
3. Seleccione el apartado llamado Identity data de los parámetros de instancia de la 

zona => Seleccione el parámetro Name => ingrese un nombre a la zona. 
4. Seleccione la pestaña  

 
 

5. Seleccione la zona y corrobore que aparezca la información de dimensiones que 
ocupa la misma. 
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Reconocimiento de Rooms en espacios Mep 
 
El reconocimiento de Rooms en espacios Mep sirve para obtener información relevante de 
la habitación. Para esto deberá contar con un proyecto donde haya Rooms colocados en 
el mismo. Este archivo debe estar en modo vinculado. Como se muestra en la ilustración. 
 

 
Pasos para reconocer los espacios Mep 

1. Seleccione el proyecto vinculado => Seleccione el botón Edit Type 

 
2. Active la casilla del parámetro Room Bounding  

 
 

3. De clic al botón OK para terminar de aplicar los cambios. 
 
Nota: El tema de creación de Rooms y áreas se ven en el diplomado de Revit Architecture, 
son herramientas propias de arquitectura.  
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Vistas de referencia  
 
Las vistas de referencia es una etiqueta que permite direccionar vistas. Solo se debe indicar 
que tipo y la vista desea direccionar. Si la vista direccionada esta colocada en un plano, en 
la etiqueta se mostrara en que plano y el numero de vista que le corresponde. 
 

1. Seleccione la pestaña Annotate => panel Tag => comando View Reference 
2. Coloque la etiqueta sobre la vista 

 
3. Seleccione la etiqueta => seleccione la pestaña Modify => Seleccione el tipo y la 

vista deseada a direccionar 
4. De doble clic sobre la etiqueta para corroborar su funcionamiento  

 
 

Esquemas de color para ductos y tuberías 
 
Los esquemas de color son una herramienta grafica que permite mostrar cierta información 
con colores. Permite dar una presentación a los proyectos de ingeniería y a su vez hacer 
toma de decisiones.  
 
Esquema de color para ductos 
 
Para colocar un esquema de ductos siga estos pasos: 
 

1. Acceda a una vista donde sea visible los ductos como se muestra en la ilustración  

 
 

2. Seleccione la pestaña Annotate => panel Color fill => comando Duct Legend 
3. De un clic sobre el área de dibujo 
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Ilustración de esquema de ductos 
 

 
 
Modificar esquema de ductos 
 

1. Seleccione la leyenda de esquema de ductos 
2. Seleccione la pestaña Modify => panel Scheme => Edit Scheme 

 
 

3. En el esquema de color, seleccione en el parámetro “Color” seleccione el parámetro 
con el que se va a filtrar la información.  

4. En los valores cambie o asigne el color y el patrón 
 

 
 

5. Cambie el titulo de las vistas de leyenda 
6. De clic al botón OK para cerrar el cuadro de dialogo. Corrobore los cambios en la 

leyenda de los ductos 
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Esquema de color para tuberías 
 
Para colocar un esquema de tuberías siga estos pasos: 
 

1. Acceda a una vista donde sea visible las tuberías como se muestra en la ilustración  

 
 

2. Seleccione la pestaña Annotate => panel Color fill => comando Pipe Legend 
3. De un clic sobre el área de dibujo 

 

 
 

4. Seleccione el modo de gestión de color del esquema de color 
 

 
 
Ilustración de esquema de tuberías  
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Modificar esquema de tuberías 
 

1. Seleccione la leyenda de esquema de tuberías 
2. Seleccione la pestaña Modify => panel Scheme => Edit Scheme 

 
 

3. En el esquema de color, seleccione en el parámetro “Color” seleccione el parámetro 
con el que se va a filtrar la información.  

4. En los valores cambie o asigne el color y el patrón 
 

 
 

5. Cambie el título de las vistas de leyenda 
6. De clic al botón OK para cerrar el cuadro de dialogo. Corrobore los cambios en la 

leyenda de los ductos 
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Publicación e impresión 
Configuración para impresión y exportación a formatos DWG 
 
Creación de configuración para exportación a formatos 
 

1. Seleccione el menú file => Export => Cad Formats => opción DWG 

 
2. Seleccione en el cuadro de exportación DWG los tres puntos del apartado Select 

Export Setup  

 
3. En la pestaña de capas ingrese el nombre que tendrá cada una de las categorías 

de Revit.  
 

 
 

4. En la pestaña de Líneas, sustituya los estilos de línea que desee del proyecto 
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5. En la pestaña de Patterns sustituya los patrones de Revit por alguno otro existente 
del formato DWG 

 

 
 

6. Seleccione la pestaña de textos y fuentes para modificar la fuente en los textos en 
el formato DWG 

 
 

7. Seleccione la pestaña Colors para gestionar los colores. 

 
▪ Index color (255 Colors): Asigna los colores en base al ID de color 
▪ Specified in objects Styles: Asigna los colores en base a los estilos de los objetos 
▪ Specified in view: Asigna los colores en base a los específicos en la vista 

 
 
 
 



 

66 
 

8. En la pestaña de solidos seleccione el tipo de geometría que se generara para las 
vistas 3D en DWG 

 
Polymesh: Geometría poligonal 
ACIS Solids: Geometría solida 
 

9. En la pestaña de unidades y coordenadas seleccione las unidades y coordenadas 
deseadas. 

 
 

10. En la pestaña general configure las propiedades de líneas de Rooms, Space, áreas, 
las opciones de visibilidad de algunos objetos y el formato. De clic en el botón OK 
para terminar de configurar las propiedades de exportación.  

 

 
 

11. Seleccione el modo de exportación, vista concurrente o una sesión de vistas 
12. Seleccione los planos en el modelo 
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13. Seleccione los planos que desea exportar. De clic al botón next… 
14. Seleccione la ruta y prefijo de guardado de los planos.  

 

 
 
Ejemplo de plano exportado a formato DWG 
 

 
 
 

Impresión de vistas de planos en Revit 
 
Creación de configuración para impresión a formatos digitales 
 

1. Seleccione el menú file => Print => Opción Print 

 
2. En la ventana de configuración de impresión, seleccione el tipo de impresora (física 

o digital)  
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3. Seleccione el modo se impresión de vistas. 

 
 

▪ Current Windows: Imprime la vista actual o activa 
▪ Visible portion of Current Windows: imprime la porción visible de la vista actual o 

activa 
▪ Selected Views/sheets: imprime las vistas o planos seleccionados 

 
4. Seleccione el botón Setup de las configuraciones Settings para modificar las 

propiedades de impresión. 

 
5. Seleccione el tamaño de papel de impresión 

 
 

6. Cuando el formato de papel sea distinto al pie de plano seleccione el zoom en modo 
Fit to page. Cuando el papel sea igual al pie de plano, seleccione el zoom al 100% 

 
7. Seleccione la orientación del papel (vertical u horizontal) 

 
8. Seleccione el modo de remover líneas, vía Vector o Raster 
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9. Seleccione las propiedades de apariencia de su plano. Raster quality es la calidad 

de impresión del plano. Colors son los colores con los que se va a imprimir el plano  
 

 
 

10.  Guarde esta configuración, asigne un nombre. De clic al botón ok para cerrar las 
configuraciones de impresión.  

 

 
 
 
 

11. Seleccione el modo de impresión de archivo.  
 

▪ Combine múltiple Selected Views/sheets into a single file: Crea un archivo con 
todos los planos combinados. 

▪ Create sepárate files. View/Sheet names Will be appended to the specified 
name: Crea un archivo por cada archivo por separado.  

 

 
 
Ejemplo de plano impreso (Digital)  
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